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RESUMEN 

Ecuador por su ubicación geográfica posee alta actividad sísmica y volcánica, según la 

Secretaría de Gestión de Riesgos (SGR) y la oficina de las Naciones Unidas para la 

Reducción del Riesgo de Desastres (UNISDR), entre 1970 y 2010 la cantidad de personas 

fallecidas y desaparecidas por evento deslizamientos y caídas ocupan la mayor cantidad 

de afectados con un valor aproximado de 1200, seguido de inundaciones con 600 

víctimas.  

La constitución de la República del Ecuador, en la sección novena, Gestión del riesgo, el 

artículo 389, indica que “El Estado protegerá a las personas, las colectividades y la 

naturaleza frente a los efectos negativos de los desastres de origen natural o antrópico 

mediante la prevención ante el riesgo, la mitigación de desastres, la recuperación y 

mejoramiento de las condiciones sociales, económicas y ambientales, con el objetivo de 

minimizar la condición de vulnerabilidad.” 

Con estos antecedentes se decide elaborar el siguiente trabajo de fin de master con la 

finalidad de identificar y difundir la susceptibilidad a deslizamientos de la parroquia 

Pomasqui, Ecuador, Suramérica. 

Considerando que el Estado ha invertido en la adquisición de fotografías aéreas (año 

2010) a una escala 1: 30 000 y distintas instituciones públicas como el IEE (Instituto 

Espacial Ecuatoriano), INIGEMM (Instituto Nacional de Investigación Geológico Minero 

y Metalúrgico), INAMHI (Instituto Nacional de Meteorología e Hidrología) e IGEPN 

(Instituto Geofísico de la Escuela Politécnica Nacional) han generado geoinformación, es 

imperativo utilizar la información generada a manera de insumos para estudios en 

diversas temáticas. 

La mayoría de metodologías eficaces resultan ser muy costosas y requieren personal 

especializado además de equipamiento de laboratorio para su implementación. A 

manera de investigación se aplica la metodología de Mora-Vahrson modificada la cual 

consiste en la ponderación de parámetros condicionantes y desencadenantes para los 

movimientos en masa, debido a las variaciones existentes en relación al lugar donde se 
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generó dicha metodología; es así que se considera como base los factores 

predominantes como: pendiente, litología, cobertura vegetal, sismicidad e intensidad 

de lluvias, lo cual permitió representar e identificar mediante el mapa de susceptibilidad 

a deslizamientos de tierra las zonas vulnerables a este evento. 

 

PALABRAS CLAVE 

Deslizamiento de tierra, Mora-Vahrson, Amenaza, SIG 
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ABSTRACT 

Ecuador by its geographical location has high seismic and volcanic activity, according to 

Secretariat of Risk Management (SGR) and the United Nations International Strategy for 

Disaster Reduction (UNISDR), between 1970 and 2010 landslides occupy the main cause 

of deaths and missing persons with 1200 affected people followed by flooding with 600 

victims 

The 389th article of the ninth section of the Ecuadorian Constitution indicate that “The 

State will protect people, masses, and nature from the negative effects of natural or 

anthropic disasters, the recovery and refurbish of the social, economic and environment 

conditions, with the aim of minimize the vulnerability condition” 

With this background, it is decided to elaborate the following master's work with the 

purpose of identifying and disseminating the susceptibility to landslides in the parish of 

Pomasqui located in Ecuador, South America. 

Considering that Ecuadorian State has invested in the acquisition of aerial photographs 

(year 2010) at 1: 30 000 scale, and different public institutions as IEE, INIGEMM, INAMHI 

and IGEPN, have generated geoinformation, it is imperative to use this information 

generated as inputs for studies in a wide range of topics. 

Most effective methodologies are very expensive and require specialized personnel as 

well as laboratory equipment for its implementation. The modified Mora-Vahrson 

methodology is applied by way of research and consisted in redefining the balance of 

constraints and triggers for landslides parameters due to the variations in relation to the 

place where the methodology was generated; thus, is kept fixed as the predominant 

factors: slope, lithology, vegetation cover, and rainfall intensity seismicity, which 

allowed to represent and identify, through the map of susceptibility to landslides, areas 

vulnerable to this event. 

KEYWORDS 

Landslide, Mora-Vahrson, Threat, GIS 
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CAPITULO I 

 

SUSCEPTIBILIDAD A DESLIZAMIENTOS DE TIERRA EN LA PARROQUIA 

POMASQUI – ECUADOR 

1. Introducción 

1.1  Antecedentes 

Ecuador se ubica en una de las zonas de más alta complejidad tectónica, en el punto de 

encuentro de las placas de Nazca y Sudamericana siendo parte del denominado cinturón 

de fuego del Pacífico, con varios volcanes en su mayoría activos, además el roce de estas 

placas tectónicas provoca una permanente actividad sísmica. 

El país por sus condiciones geomorfológicas y el efecto de la actividad humana es 

propenso a procesos de deslizamientos, avalanchas de lodo, erosión y caídas, cuando se 

producen episodios climáticos de intensas lluvias. Las actividades antrópicas pueden 

originar procesos de movimientos en masa particularmente cuando se construyen obras 

de infraestructura de gran magnitud sin tomar en consideración las propiedades físicas 

y mecánicas del suelo y subsuelo. 

De acuerdo a los registros históricos el Ecuador está marcado por una serie de eventos 

catastróficos, siendo los movimientos en masa uno de los eventos que han causado 

graves consecuencias además de pérdidas económicas e impactos negativos sociales y 

políticos, resultando particularmente vulnerables aquellas poblaciones situadas en 
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áreas rurales y con más bajo nivel escolar, donde se pueden mencionar: deslizamiento 

de La Josefina en el año 1993 afectando el Río Paute y sus consecuencias fueron 50 

personas fallecidas y 147 millones de dólares en daños directos; deslizamiento 

Quebrada Huangu en el año 2001 cerca de la Vía Papallacta – Baeza con consecuencias 

de 26 muertos, rotura del poliducto, derrame de petróleo, obstrucción de la carretera y 

daños ambientales. 

Según datos del Distrito Metropolitano de Quito (DMQ), en la época invernal de octubre 

del 2015 a mayo del 2016 se registraron 300 episodios generados por fuertes aguaceros, 

137 inundaciones, 104 movimientos en masa, el colapso de 44 estructuras y diez 

episodios de vientos fuertes. 

Los movimientos en masa generalmente se producen en épocas lluviosas o a causa de 

un sismo, es así que dependiendo de su magnitud destruye todo lo que a su paso 

encuentra, Ecuador es un país montañoso y al recibir una gran cantidad de agua la tierra 

se ablanda y se desprende formando flujos de lodo que se precipitan pendiente abajo. 

Además, que algunas personas contribuyen a que ocurran estos movimientos en masa, 

cuando construyen con materiales pesados sobre terrenos débiles o cuando realizan 

excavaciones desestabilizando las laderas, otro factor causante de deslizamientos y 

caídas es la deforestación ya que el suelo queda desprotegido. 

El presente trabajo propone aplicar una metodología sencilla y de bajo costo, que 

permita identificar zonas susceptibles a inestabilidad de terrenos, con el fin de mostrar 

su aplicabilidad y eficacia. 

 

1.2  Justificación 

Los movimientos de tierra que han ocurrido en Ecuador por factores condicionantes y 

detonantes, son considerados en la actualidad una tarea de gran interés para la 

educación ambiental y además fundamental para la gestión de riesgos en donde se 

identifican amenazas, factores de vulnerabilidad y posibles áreas afectadas en caso de 
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producirse un evento adverso, por lo cual son considerados un elemento de suma 

importancia en las tareas del Ordenamiento Territorial. 

Las principales amenazas de origen natural presentes en la parroquia, se relacionan con 

la probabilidad de ocurrencia de eventos: sísmicos, fenómenos volcánicos (ceniza, flujos 

piroclásticos), deslizamientos y caídas. 

La parroquia Pomasqui presenta susceptibilidad: extrema en zonas de mínima superficie 

ubicadas al norte de la cabecera parroquial; susceptibilidad moderada: en la zona de 

mayor superficie que se encuentra en todo el sector noroeste y una susceptibilidad baja 

que se encuentra de manera inmediata alrededor del límite urbano de Pomasqui. (PDOT 

Pomasqui, 2012-2025).  

Se consideró realizar esta disertación de la parroquia Pomasqui, ya que no cuenta con 

estudios sobre riesgo de desastre por lo que se precisa identificar los posibles niveles de 

riesgo ante deslizamientos y caídas para poder plantear propuestas y lineamientos que 

reduzcan los mismos. La importancia del estudio del riesgo de desastre radica en que es 

posible plantear alternativas para mejorar la gestión del territorio. En consecuencia, los 

resultados esperados pueden ser de utilidad tanto para los moradores como para las 

autoridades del sector, porque ofrecen soluciones que pueden evitar daños materiales 

y pérdidas humanas. 

 

1.3  Área de Estudio 

1.3.1 Descripción de la zona de estudio 

La parroquia Pomasqui está muy cerca de Quito siendo la que mayor influencia urbana 

ha recibido, sin embargo, de lo cual mantiene su identidad y expresiones culturales. 

Está ubicada a una altura de 2350 msnm, tiene 23,16 km2 de extensión. 

Su clima varía entre 14 °C - 17 °C y ha reportado una pluviosidad comprendida entre 300 

a 1.100mm. Se trata de una región semiárida, con un clima primaveral. (PDOT Pomasqui, 

2012-2025). 
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1.3.2 Ubicación Geográfica 

La parroquia Pomasqui se encuentra situada al norte de la ciudad de Quito y sus límites 

los constituyen al norte con San Antonio de Pichincha, al sur con Cotocollao y Carcelén, 

al este con Calderón y al oeste con Cotocollao y Calacalí. Su ubicación se muestra en la 

ilustración 1.1. 

 

Ilustración 1.1. Ubicación geográfica parroquia Pomasqui 

 

1.4  Objetivos 

1.4.1 Objetivo general 

Determinar los niveles de amenaza ante posibles movimientos de masa (deslizamientos 

y caídas) de la parroquia Pomasqui utilizando técnicas de SIG y fotointerpretación con 

la metodología de Mora-Vahrson modificada. 
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1.4.2 Objetivos específicos 

- Determinar y sectorizar el nivel de amenaza de los movimientos en masa 

(deslizamientos y caídas) de la parroquia Pomasqui. 

- Analizar la susceptibilidad para deslizamientos y caídas. 

- Analizar los factores de disparo para el fenómeno de movimientos en masa 

(deslizamientos y caídas). 

- Obtener el mapa de amenazas de movimientos en masa (deslizamientos y 

caídas) de la parroquia Pomasqui. 
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CAPITULO II 

2. MARCO TEÓRICO 

2.1  Movimientos en masa 

Los movimientos en masa son parte de los procesos denudativos que modelan la 

superficie de la tierra. Su origen obedece a una gran diversidad de procesos geológicos, 

hidrometeorológicos, químicos y mecánicos que se dan en la corteza terrestre y en la 

interface entre esta, la hidrósfera y la atmósfera (Varnes, 1978). 

 

Deslizamientos 

 

Es un desplazamiento ladera abajo de una masa de suelo o roca, cuyo movimiento 

ocurre predominantemente a lo largo de una superficie de falla o de una delgada zona 

en donde ocurre una gran deformación cortante; se clasifica según la forma del plano 

de deslizamiento: rotacionales y traslacionales (Varnes, 1978). 

- Deslizamiento rotacional se da donde la superficie de ruptura es curva, la masa 

rota hacia atrás alrededor de un eje paralelo a la ladera. Este tipo de mecanismo 

es característico de suelos cohesivos homogéneos y de macizos rocosos 
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intensamente fracturados. En materiales arcillosos, especialmente si hay 

presencia de agua. 

Los deslizamientos rotacionales, una vez producidos, son susceptibles de 

reactivación. El movimiento tiende a estabilizarse por disminución del momento 

de giro y aumento del momento estabilizador. 

 

 

Ilustración 2.1. Deslizamiento rotacional (Skinner & Porter, 1992) 

 

- Deslizamiento traslacional se da cuando la superficie de ruptura es más o menos 

plana o ondulada y la masa se mueve paralela a la superficie del terreno. 

Los componentes de la masa desplazada se mueven a la misma velocidad y 

siguen trayectorias paralelas. A medida que un deslizamiento traslacional 

progresa puede romperse, en particular si aumenta la velocidad. Entonces, la 

masa disgregada deviene un flujo. 
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Ilustración 2.2. Deslizamiento traslacional (Skinner & Porter, 1992) 

 

Caídas 

 

Todas las caídas se inician con un desprendimiento de suelo o roca de una ladera muy 

empinada, a lo largo de una superficie en la que poco o ningún desplazamiento cortante 

se desarrolla. El material desciende en caída libre, saltando o rodando, el movimiento 

es muy rápido a extremadamente rápido (Cruden & Varnes, 1996). 

Solo cuando la masa desplazada es socavada, las caídas son precedidas por pequeños 

deslizamientos o movimientos de basculamiento que separan el material de la masa no 

perturbada (Cruden & Varnes, 1996). 

Socavamiento ocurre típicamente en suelos cohesivos o rocas al pie de escarpes que 

sufren el ataque de las olas o debido a la erosión de márgenes de ríos. 

Las caídas con una trayectoria básicamente vertical de abrigos desarrollados en 

acantilados por la socavación efectuada por un río, el oleaje o la meteorización y 

disgregación de las rocas a su pie son consideradas colapsos (García Yagüe y García 

Álvarez, 1988). El material caído, una vez desparramado por la ladera, no suele 

experimentar nuevos movimientos. Cuando las caídas son frecuentes, los bloques se 

acumulan al pie de los escarpes rocosos formando canchales que ocasionalmente 

experimentan roturas y originan corrientes de derrubios (Van Steijn et al. 1988). El área 

fuente de desprendimientos es de difícil acceso. 
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Ilustración 2.3. Mecanismos de desprendimiento y colapso (Corominas y García Yagüe, 1997) 

  

2.2 Método Mora-Vahrson 

La metodología utilizada consiste en la ponderación de parámetros condicionantes y 

desencadenantes para los tipos de movimientos en masa. 

2.2.1 Información preliminar o secundaria 

Es necesaria la recopilación de información preliminar que permita tener una base 

sustentable para la elaboración del presente estudio, la información a utilizarse es la 

siguiente: 

- Cartografía base a escala 1:50 000 (IGM) 

- Mapa de uso y cobertura de suelo escala 1:25 000 (IEE-MAGAP) 

- Informe de sismos de la zona en estudio (IGE-PN) 

- Registro de precipitaciones e intensidad de lluvia (INAMHI) 

- Ortofotomosaico (SIGTIERRAS) 

- Mapa Geológico (INIGEM) 



 

 MASTER EN INGENIERÍA GEOMÁTICA Y GEOINFORMACIÓN 

 SUSCEPTIBILIDAD A DESLIZAMIENTOS DE TIERRA EN LA PARROQUIA POMASQUI - ECUADOR 

 

18 
 

2.2.2 Metodología de Mora-Vahrson 

Dentro de la metodología se aplica la combinación de factores condicionantes y 

desencadenantes, los mismos que se obtienen de la observación y medición de 

indicadores morfodinámicos y su distribución espacio-temporal. 

La combinación de los factores se realiza considerando que los movimientos en masa 

(deslizamientos y caídas) ocurren cuando en una ladera compuesta por una litología 

determinada con cierto grado de humedad y con cierta pendiente, se alcanza un grado 

de susceptibilidad (elementos pasivos) (Mora, R. et al., 1993). Bajo estas condiciones, 

los externos y dinámicos, como son la sismicidad y las lluvias intensas (elementos 

activos) actúan como factores de disparo que perturban el equilibrio, la mayoría de las 

veces precario, que se mantiene en la ladera (Mora, R. et al., 1993). 

Es así como se considera que el grado de susceptibilidad al deslizamiento es producto 

de los elementos pasivos y de la acción de los factores de disparo (Mora, R. et al., 1993). 

𝐻 = (𝑆𝑟 × 𝑆ℎ × 𝑆𝑙)×(𝑇𝑠 + 𝑇𝑝) 

donde: 

𝐻: Grado de amenaza 

𝑆𝑟: Factor relieve relativo 

𝑆ℎ: Factor humedad del suelo 

𝑆𝑙: Factor litología 

𝑇𝑠: Factor de disparos por sismos 

𝑇𝑝: Factor de disparos por precipitaciones 

 

Esta metodología por si misma resulta aplicable a países en vías de desarrollo, debido a 

que requieren pocas variables morfodinámicas y su aplicación es relativamente sencilla, 

incluye los factores más significativos desde el punto de vista de la inestabilidad de 

laderas, se basa en parámetros que puedan determinarse de manera ágil y económica. 

Los mapas generados con esta metodología pueden ser utilizados como insumos en la 

toma de decisiones para los procesos de planificación del uso del terreno, planificación 
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urbana y de líneas vitales (Mora, R. et al., 1993), evaluaciones de amenazas por 

deslizamientos y en planes de gestión de riesgo. 

La metodología no sustituye a los estudios geotécnicos de campo y laboratorio, 

necesarios para el diseño y concepción de las obras civiles y sus complementos de 

protección y mitigación correspondientes, y que tampoco es capaz de pronosticar el tipo 

de deslizamiento que podría presentarse (Mora, R. et al., 1993). 

2.2.3 Metodología de Mora-Vahrson modificada aplicada 

Los factores condicionantes y detonantes considerados para el análisis de 

susceptibilidad de deslizamientos y caídas se presentan en la siguiente fórmula: 

𝐻 =  𝑆 ×𝐹𝐶 

𝑆 = (𝑆𝑚 × 𝑆𝑐 × 𝑆𝑙) 

𝐹𝐶 = (𝑇𝑠 + 𝑇𝑝) 

𝐻 = (𝑆𝑚 × 𝑆𝑐 × 𝑆𝑙) × (𝑇𝑠 + 𝑇𝑝) 

donde: 

𝐻: Grado de amenaza de las unidades geomorfológicas 

𝑆: Grado de susceptibilidad 

𝐹𝐶: Factores detonantes 

𝑆𝑚: Factor pendiente 

𝑆𝑐: Factor cobertura vegetal 

𝑆𝑙: Factor litología 

𝑇𝑠: Factor de disparo por sismos 

𝑇𝑝: Factor de disparo por precipitaciones 
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Ilustración 2.4. Factores condicionantes y detonantes considerados en el modelo 

 

2.2.4 Cuantificación de la amenaza 

Para la cuantificación de amenaza se utilizó la metodología correspondiente a la 

Metodología de Mora-Vahrson modificada, incluyendo adaptaciones de acuerdo a la 

información preliminar disponible para la generación del modelo. 

Para su aplicación se considera dos tipos de movimiento en masa: deslizamientos y 

caídas; donde los factores de susceptibilidad y disparo son tratados de manera 

independiente. 

Cabe recalcar que para deslizamientos y caídas solo se ponderan los factores 

condicionantes, más no los factores detonantes ya que su ponderación será la misma 

para ambos casos. 

Los valores de ponderación para cada parámetro guardan relación con las clases 

determinadas durante el transcurso del proyecto. Se realiza las operaciones entre 

factores condicionantes para la ocurrencia de movimientos en masa por tipo de 

movimiento. 

Posteriormente, se relaciona los factores detonantes para la categorización de la 

amenaza por movimientos en masa. 

 

Factores 
considerados 
en el modelo

Factores 
condicionantes

Sm Pendiente
Valor de 

pendientes

Sl Litología Tipo de roca

Sc
Cobertura 

vegetal

Tipo de 
cobertura 

vegetal

Factores 
detonantes

Ts
Intensidad 

sísmica
Registro de 

sismos

Tp
Intensidad de 

precipitaciones

Intensidad 
máxima en 24 

horas
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Análisis de susceptibilidad 

Para establecer el grado de susceptibilidad, se analizan los siguientes factores: 

- Factores condicionantes: 

 Sm Factor pendiente 

 Sl Factor litológico 

 Sc Factor cobertura vegetal 

- Factores de disparo: 

 Tp Precipitaciones 

 Ts Sismos 

 

2.2.5 Factor pendiente (Sm) 

Correspondiente a las características morfométricas de las unidades geomorfológicas, 

en la cual se consideran las clases de pendientes de acuerdo a la clasificación utilizada 

en la fotointerpretación geomorfológica. 

Tabla 2.1. Categorización de pendiente 

Rangos (%) Clase Descripción 

0 - 12 1 

Relieves completamente planos, casi planos y 
ligeramente ondulados. 
Además de todas las áreas que no son suelo como: 
centros poblados, ríos dobles o con características 
similares a estas al representarlas o cartografiarlas 

12 - 25 2 
Relieves medianamente ondulados a moderadamente 
disectados. 

25 - 40 3 Relieves mediana a fuertemente disectados. 

40 - 70 4 Relieves fuertemente disectados 

70 -100 5 Relieves muy fuertemente disectados 

100 - 150 6 Relieves escarpados. 

150 - 200 7 Relieves muy escarpados. 

>200 8 
Corresponde a las zonas reconocidas como mayores a 
200% en el mapa de pendientes. 

Fuente: Mora, R. et al., 1993 
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2.2.6 Factor litológico (Sl) 

Los tipos de suelo y roca juegan un papel predominante en el comportamiento dinámico 

de las laderas. 

La litología se considera como un factor de susceptibilidad importante para la ocurrencia 

del fenómeno de remoción en masa. Se refiere a la composición de las unidades 

geomorfológicas en cuanto a su sustrato rocoso y a los depósitos superficiales. Es un 

factor determinante para la identificación de la amenaza por movimientos en masa, por 

lo que es necesario describir lo más específico posible (Mora, R. et al., 1993). Se tomará 

en cuenta la categorización realizada por la metodología de Mora-Vahrson. 

Tabla 2.2. Categorías del factor litológico 

Valor del 
parámetro 

Litología 
Características 
físicomecánicas 

típicas 

1 

Aluviones: gruesos, permeables, compacto, con nivel freático 
bajo. 
Calizas: duras, permeables. Intrusivos: poco fisurados, bajo nivel 
freático. 
Basaltos, andesita, ignimbritas y similares: sanas, permeables y 
poco fisuradas. 
Rocas metamórficas: sanas, poco fisuradas, nivel freático bajo 

Sanos con poco o 
ninguna meteorización, 
resistencia al corte: 
elevada, fisuras sanas 
sin rellenos. 

2 

Rocas sedimentarias: poco alteradas, estratificación maciza 
(decamétrica o métrica), poco fisuradas, nivel freático bajo. 
Rocas intrusivas, calizas duras, lava, ignimbritas o 
metamórficas: medianamente fisuradas o alteradas, nivel 
freático a profundidades intermedias. 

Resistencia al corte: 
media a elevada, 
fracturas cizallables. 

3 

Rocas sedimentarias, rocas intrusivas, calizas duras, lava, 
ignimbritas, tobas poco soldadas o metamórficas: 
medianamente alteradas. 
Coluvios, lahares, arenas, suelos regolíticos levemente 
compactados: drenaje poco desarrollado, niveles freáticos 
relativamente altos 

Resistencia al corte: 
moderada a media, 
fracturación 
importante. 

4 

Aluviones fluvio-lacustres, suelos piroclásticos poco 
compactados, sectores de alteración hidrotermal, rocas 
fuertemente alteradas y fracturadas con estratificaciones y 
foliaciones a favor de la pendiente, con rellenos arcillosos, 
niveles freáticos someros 

Resistencia al corte: 
moderada a baja. 

5 

Materiales aluviales, coluviales y regolíticos de muy baja calidad 
mecánica: con estado de alteración avanzado, drenaje pobre, se 
incluyen las categorías 3 y 4 con niveles freáticos muy someros, 
sometidos a gradientes hidrodinámicos muy elevados. 

Resistencia al corte: 
muy baja, materiales 
blandos con muchos 
finos. 

Fuente: Salazar, 1991 



 

 MASTER EN INGENIERÍA GEOMÁTICA Y GEOINFORMACIÓN 

 SUSCEPTIBILIDAD A DESLIZAMIENTOS DE TIERRA EN LA PARROQUIA POMASQUI - ECUADOR 

 

23 
 

Un aporte importante en la definición de este parámetro lo realiza Mora-Vahrson al 

incluir las descripciones de los macizos rocosos y la evaluación de la propiedad 

geotécnica de los suelos, para lo cual incorpora cuadros para obtener la valoración de 

los parámetros (Mora, R. et al., 1993). 

 

2.2.7 Factor cobertura vegetal (Sc) 

La experiencia ha demostrado el efecto positivo de la vegetación para evitar problemas 

de erosión, reptación y fallas subsuperficiales (Suárez, 1998). La vegetación con mayor 

densidad de follaje amortigua más eficientemente el golpe de la lluvia y disminuye la 

erosión. En hierbas y pastos la densidad y volumen del follaje actúan como un colchón 

protector contra los efectos erosivos del agua de escorrentía. Para el control de erosión 

se determina que árboles altos la erosión es menor que en el caso de arbustos (Suárez, 

1998). La cobertura vegetal se ha categorizado por los siguientes grupos: 

Tabla 2.3. Categorías del factor de cobertura vegetal 

Categoría Calificativo Descripción 

Bosques 
Cultivos 
permanentes 
Manglares 

Alta cobertura 

Bosque: Ecosistema arbóreo, primario o secundario, regenerado por 
sucesión natural, que se caracteriza por la presencia de árboles de 
diferentes especies nativas, edades y portes variados, con uno o más 
estratos. 
Cultivos: Comprenden aquellas tierras dedicadas a cultivos agrícolas cuyo 
ciclo vegetativo es mayor a tres años, y ofrece durante éste periodo varias 
cosechas. 

Vegetación arbustiva 
Vegetación herbácea 
Páramos 
Cultivos 
semipermanentes 
Cultivos anuales 
Agropecuario mixto 

Baja cobertura 

Vegetación Arbustiva: Áreas con un componente substancial de especies 
leñosas nativas cuya estructura no cumple con la definición de bosque. 
Vegetación Herbácea: Vegetación dominante constituida por especies 
herbáceas nativas con un crecimiento espontáneo, que no reciben 
cuidados especiales, utilizados con fines de pastoreo esporádico, vida 
silvestre o protección. Vegetación desarrollada en abruptos o sobre 
cangagua. 
Páramo: Incluye ecosistemas de páramo denso y en distintas etapas de 
recuperación después de disturbios antrópicos. 
Cultivo Semipermanente: Comprenden aquellas tierras dedicadas a 
cultivos agrícolas cuyo ciclo vegetativo dura entre uno y tres años. 
Cultivo Anual: Comprende aquellas tierras dedicadas a cultivos agrícolas, 
cuyo ciclo vegetativo es estacional, pudiendo ser cosechados una o más 
veces al año. 
Agropecuario mixto: Comprende las tierras usadas para diferente clase de 
cultivos donde se uso está caracterizado por variedad de productos 
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Sin cobertura 
Zonas erosionadas 
Proceso de erosión 

Sin cobertura 
Áreas con poca o ninguna cobertura vegetal. Incluye playas, desiertos, 
gravas, salina industrial, salina natural, afloramientos rocosos y áreas 
erosionadas por procesos naturales o de origen antrópico 

Infraestructura 
Mediana 
cobertura 
(antrópica) 

Establecimiento de un grupo de personas en un área determinada, 
incluyendo la infraestructura civil que lo complementa. 

Fuente: IEE, 2015 

 

2.2.8 Factor de disparo por precipitaciones (Tp) 

Dentro de la metodología escogida, se considera a la intensidad de precipitación como 

factor de disparo. El Instituto Nacional de Hidrología y Meteorología (INHAMI), a partir 

de la aplicación de la metodología de Mora–Vahrson y con base a los registros de 

estaciones meteorológicas determinó que a nivel nacional existe una precipitación 

máxima en 24 horas de 245 mm para un periodo de retorno de 100 años, a partir de 

este valor se presentó el cuadro para calificar el factor detonante para precipitaciones. 

Tabla 2.4. Categorización del factor disparo por precipitaciones 

Precipitación 
máximas 24 horas 

Calificativo 

< 100 Muy bajo 

100 - 150 Bajo 

150 - 200 Mediano 

200 - 250 Alto 

> 250 Muy alto 

Fuente: Mora, R. et al., 1993 

2.2.9 Factor de disparo por sismos (Ts) 

Los movimientos en masa producidos por actividad sísmica se dan por su intensidad. 

Para la categorización de este factor de disparo (tabla 2.5) se basó en el cuadro 

comparativo entre la intensidad y la magnitud de los sismos de Mora-Vahrson (1993). 

Considerando los efectos que tiene la magnitud de los sismos en la superficie se deberá 

seguir la siguiente ponderación para el factor de disparo por sismos. 
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Tabla 2.5. Categorización del factor disparo por sismicidad 

Rangos 
Magnitud 

Richter 
Calificativo 

< 3,5 Nulo 

3,5 - 4,4 Muy bajo 

4,5 - 5,9 Bajo 

6,0 - 6,9 Mediano 

7,0 - 7,9 Alto 

> 8,0 Muy alto 

Fuente: IEE, 2015 

2.2.10 Determinación del Grado de amenaza (H) 

Una vez establecidos las ponderaciones de cada factor y sus respectivos coeficientes, se 

procede a determinar el valor y grado de amenaza para los procesos de deslizamientos 

y caídas. 

El grado de amenaza se lo obtuvo en valores del uno al cinco, los cuales se agruparon 

para calificar el grado de amenaza en muy bajo, bajo, moderada, alto y muy alto. 

Tabla 2.6. Calificativo del grado de amenaza para la ocurrencia de deslizamientos y caídas 

Calificativo de 
amenaza 

Muy Bajo 

Bajo 

Moderado 

Alto 

Muy Alto 

Fuente: IEE, 2015 
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CAPITULO III 

 

3. METODOLOGÍA 

3.1  Información base 

Para la elaboración de los mapas se utilizó la siguiente información: 

- Cartografía base a escala 1:50 000 (IGM) 

- Mapa de uso y cobertura de suelo escala 1:25 000 (IEE-MAGAP) 

- Informe de sismos de la zona en estudio (IGE-PN) 

- Registro de precipitaciones e intensidad de lluvia (INAMHI) 

- Ortofotomosaico (SIGTIERRAS) 

- Mapa Geológico (INIGEM) 

3.2 Factor pendiente (Sm) 

La ponderación para deslizamientos se basa en la premisa que a mayor pendiente es 

mayor la probabilidad de que ocurra un deslizamiento (Mora, R., 2004). 

Dentro de la ponderación para deslizamientos se consideran las pendientes >12%, las 

pendientes con valores inferiores a éste serán consideradas como una susceptibilidad 

nula, mientras que para caídas se consideran a partir de pendientes >40% (PMA, 2007)  
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Tabla 3.1. Ponderación – Factor pendiente (SM) 

Rangos (%) 

Ponderación 

Deslizamientos (SM) Caídas (SM_C) 

0 - 12 0 0 

12 - 25 1 0 

25 - 40 2 0 

40 - 70 3 1 

70 -100 4 2 

100 - 150 5 3 

150 - 200 5 4 

>200 5 5 

Calificativo susceptibilidad 
Nulo = 0 ; Muy bajo = 1 ; Bajo = 2 ; Moderado = 3 ; Alto = 4 ; Muy Alto = 5 

Fuente: IEE, 2015 

 

3.2.1 Mapa de pendientes. 

 

A partir del MDE (Modelo de elevación) con tamaño de celda 5x5m se creó el mapa de 

pendientes, utilizando la herramienta SLOPE. Donde para cada celda, esta herramienta 

calcula la tasa máxima de cambio del valor de esa celda a sus vecinos. Básicamente, el 

cambio máximo en la elevación sobre la distancia entre la celda y sus ocho vecinos 

identifica el descenso cuesta abajo más empinado desde la celda. 

Las pendientes más empinadas están sombreadas en grises en el ráster de pendiente de 

salida. 

Esta herramienta se encuentra en ArcToolBox en: Arctoolbox > spatial analyst tools > 

surface > slope. 

Para emplearlo con la metodología, las unidades de medida de los datos de salida de la 

pendiente serán en porcentaje.  
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Input elevation raster 

  Output slope raster (%) 

Ilustración 3.1. Representación de pendientes 

 

Para clasificarlo y ponderarlo dentro de los parámetros propuestos por la metodología 

se usó la herramienta RECLASSIFY 

Esta herramienta se encuentra en ArcToolBox > Spatial Analyst Tools > Reclass > 

Reclassify 

    

Ilustración 3.2. Ponderación factor pendientes – Deslizamientos 
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Se realizó el mismo procedimiento para la reclasificación para caídas con diferente 

ponderación. 

    

Ilustración 3.3. Ponderación factor pendientes – Caídas 

 

3.3 Factor litológico (Sl) 

Se ponderó el factor litológico de diferente manera para deslizamientos y caídas 

Tabla 3.2. Ponderación – Factor litológico (SL) 

Formación geológica Litología 

Ponderación 

Deslizamientos 
(SL) 

Caídas (SL_C) 

Depósito Aluvial Gravas, arenas en matriz areno-arcilloso 5 1 

Depósito Coluvial 
Arenas de grano medio a grueso, gravas y 
cantos subangulares a angulares 

4 2 

Formación Cangahua 
Depósitos de toba volcánica y ceniza, en la 
base se encuentran piroclastos, pómez y 
lapilli 

3 3 

Calificativo susceptibilidad 
Nulo = 0 ; Muy bajo = 1 ; Bajo = 2 ; Moderado = 3 ; Alto = 4 ; Muy Alto = 5 

Fuente: IEE, 2015 

 

3.3.1 Mapa de Geomorfología 

 

A partir de las ortofotos se realizó fotointerpretación mediante la utilización de un SIG, 

tomando como material de referencia cartas geológicas, topográficas y el MDT, en las 

ortofotos se interpreta el tipo de geoforma en base a la simetría, colores, tonos, 

texturas, formas y se codifican las diferentes unidades, generando así una geodatabase. 
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Fotointerpretación digital Es la técnica que permite la obtención de información 

primaria, bajo la premisa de que los aspectos geológicos: tipo de roca, formaciones 

superficiales, tectónica; aspectos geomorfológicos: morfología, morfometría, 

morfodinámica; aspectos hidrográficos: densidad, forma del drenaje; uso del suelo; 

movimientos en masa; infraestructura, etc., son claramente identificables y susceptibles 

de ser analizados a través de la observación estereoscópica. La misma se fundamenta 

en conocimientos integrales que posibilitan un análisis sistémico de manera contextual. 

La finalidad es llegar al entendimiento de la existencia de cada unidad, sus características 

y su relación con las unidades que la rodean, ya que en el espacio geográfico todas las 

variables se interrelacionan en un sistema ordenado y coherente. 

 

Ilustración 3.4. Fotointerpretación de Geomorfología 

 

El proceso de fotointerpretación digital cubre los siguientes pasos: 

- Estudio y definición de unidades ambientales, de acuerdo al libro y mapa “Los 

Paisajes Naturales del Ecuador” de A. Winckell (1997), que proveen un marco 

general para la interpretación ya que determina la variabilidad de las unidades 

geomorfológicas que pueden encontrarse en su interior, relacionadas con su 
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génesis, material parental y otras características, en base a un análisis sistémico. 

Adicionalmente se debe tener un conocimiento cabal de la litología, tectónica y 

evolución geológica general del área a estudiar. 

- Demarcación de la red de drenaje: Es importante en las zonas de cambio del tipo 

de roca. 

- Definición y caracterización de las unidades geomorfológicas: La asignación del 

tipo de roca a la unidad geomorfológica se basa en el patrón del drenaje, y en los 

datos geológicos secundarios recopilados. 

- Ingreso de las variables a la geodatabase de manera simultánea a la 

interpretación digital. 

La interpretación digital, realizada directamente en pantalla, debe cumplir los siguientes 

pasos: 

- Digitalización a escala estándar mediante líneas que aparezcan suavizadas y 

tengan concordancia con el MDT y las curvas de nivel. Se debe tener en cuenta 

la red hidrográfica y demás elementos relevantes de la cartografía base. 

- Enlace de las unidades geomorfológicas entre el aspecto gráfico con el 

alfanúmerico, codificación realizada simultáneamente a la fotointerpretación 

digital. Para tal fin, se utiliza la geodatabase según el diseño de la siguiente tabla. 

Tabla 3.3. Diseño campos geodatabase - Morfología 

OBJECTID Pendiente área 

U_genet R_pendient AMENAZA 

U_morfol Geología  

Cod Litología  

   

 

A partir de la hoja 84 – NW, con nombre EL QUINCHE del mapa geológico del Ecuador, 

escala 1:50 000, se localizó el área de estudio y se diferenció cada una de las formaciones 

y símbolos geológicos, además se obtuvo mayor información de la litología de la breve 

explicación de la geología en la misma hoja. 
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El levantamiento geológico fue realizado por el Dr. R. Bristow del Instituto de Ciencias 

Geológicas de Londres, Ing. K. Burgos de la Dirección General de Geología y Minas, en el 

año 1974. 

 

Una vez definidas las unidades de litología se convirtió la clase de entidad shapefile a un 

dataset ráster 

Esta herramienta se encuentra en ArcToolBox > Conversion Tools > To Raster > Feature 

to Raster 

Para reclasificarlo dentro de los parámetros propuestos por la metodología se usó la 

herramienta RECLASSIFY 

Esta herramienta se encuentra en ArcToolBox > Spatial Analyst Tools > Reclass > 

Reclassify 

 

Ilustración 3.5. Ponderación factor litológico – Deslizamientos 
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Se realizó el mismo procedimiento para la reclasificación para caídas con diferente 

ponderación, según la metodología. 

 

Ilustración 3.6. Ponderación factor litológico – Caídas 

 

3.4 Factor cobertura vegetal (Sc) 

Para la generación del modelo, con la base de datos de uso y cobertura del suelo, se 

utiliza las mismas ponderaciones de cobertura vegetal para deslizamientos y caídas. 

Tabla 3.4. Ejemplos de ponderaciones del parámetro cobertura vegetal (Sc) 

Cobertura Vegetal 

Categoría Cobertura Uso 
Ponderación 

SC 

Plantación forestal 
Eucalipto Protección o producción 1 

Pino Protección o producción 1 

Vegetación arbustiva 

Matorral húmedo 
medianamente alterado 

Conservación y 
protección 

3 

Matorral seco muy alterado 
Conservación y 
protección 

3 

Matorral seco poco alterado 
Conservación y 
protección 

3 

Mosaico 
agropecuario 

Misceláneo de frutales Agropecuario mixto 3 
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Pastizal Pasto cultivado Pecuario 3 

Vegetación herbácea 
Vegetación herbácea seca 
poco alterada 

Conservación y 
producción 

3 

Área poblada 

Área en proceso de 
urbanización 

Antrópico 4 

Centro poblado Antrópico 4 

Infraestructura 
antrópica 

Complejo educacional Antrópico 4 

Complejo industrial Antrópico 4 

Complejo recreacional Antrópico 4 

Granja avícola Avícola 4 

Cultivo Maíz Agrícola 4 

Mosaico 
agropecuario 

Misceláneo de ciclo corto Agropecuario mixto 4 

Misceláneo de hortalizas Agropecuario mixto 4 

Infraestructura 
antrópica 

Subestación eléctrica Antrópico 4 

Área poblada Urbano Antrópico 4 

Vegetación herbácea 

Vegetación herbácea seca 
medianamente alterada 

Conservación y 
producción 

4 

Vegetación herbácea seca 
muy alterada 

Conservación y 
producción 

4 

Erial 
Área en proceso de erosión Tierras improductivas 5 

Área erosionada Tierras improductivas 5 
Fuente: IEE – MAGAP, 2015 

 

3.4.1 Mapa de cobertura vegetal. 

 

Del proyecto “GENERACIÓN DE GEOINFORMACIÓN PARA LA GESTIÓN DEL TERRITORIO 

A NIVEL NACIONAL ESCALA 1: 25 000”, elaborado en diciembre del año 2013, por el IEE 

(Instituto Espacial Ecuatoriano), se tomó la cartografía de Cobertura y Uso de la Tierra 

del Distrito Metropolitano de Quito, Provincia de Pichincha, que fue realizada mediante 

la interpretación interdependiente sobre un mosaico de ortofotos e imágenes con fecha 

de toma de la información de los años de 2010-2011. A continuación, se explicará 

brevemente la metodología utilizada. 

La estructura de datos preliminar (tabla de atributos) de la capa de Cobertura, Uso de la 

Tierra, parcelas, riego. 
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- Mejoramiento de Ortofotos. Las ortofotos, son sometidas a procesos de mejora, 

según la calidad de las mismas, con la finalidad de resaltar los colores, tonos, 

texturas y formas de los elementos de las diferentes coberturas. 

- Interpretación Visual en Pantalla y Codificación. Las ortofotos se someten a 

interpretación visual en la pantalla de un computador, mediante la utilización de 

un GIS, en las ortofotos se interpreta la cobertura y uso de la tierra, se define el 

tamaño de parcelas, zonas bajo riego en base a la simetría, colores, tonos, 

texturas, formas y se codifican las diferentes unidades de acuerdo a la leyenda 

temática pre-establecida, obteniéndose como producto los mapas preliminares 

de Cobertura, Uso de la Tierra, tamaño de parcelas y riego. 

A partir de este shapefile de Cobertura Vegetal, se localizó el área de estudio y se 

intersecó con el shapefile de geomorfología de elaboración propia con el fin de extraer 

las características de la cobertura vegetal y posteriormente aplicar el valor de 

ponderación correspondiente. 

 

Ilustración 3.7. Cobertura Vegetal Parroquia Pomasqui 
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Una vez definidos los valores de acuerdo a la ponderación propuesta por la metodología, 

se convirtió la clase de entidad shapefile a un dataset ráster 

Esta herramienta se encuentra en ArcToolBox > Conversion Tools > To Raster > Feature 

to Raster 

 

Ilustración 3.8. Ponderación factor Cobertura Vegetal 

 

3.5 Grado de susceptibilidad para movimientos en masa 

Se calcula el grado de susceptibilidad para movimientos en masa, utilizando los campos 

ponderados de cada factor condicionante, utilizando la siguiente fórmula: 

𝑆 =  𝑆𝑚 × 𝑆𝑙 × 𝑆𝑐 

Considerando que existen dos ponderaciones diferentes para Deslizamientos y Caídas, 

se realizaron las multiplicaciones independientemente. 

La fórmula de los factores detonantes para la ocurrencia de los movimientos en masa es 

la siguiente: 

𝐹𝐶 =  𝑇𝑠 +  𝑇𝑝 
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Tomando en cuenta que para deslizamientos los valores máximos de los factores: 

- Pendiente: 5 

- Cobertura vegetal: 5 

- Litología: 5 

La respectiva multiplicación que corresponde a susceptibilidad de deslizamientos 

presentó como valores mínimos y máximos de 0 y 100 correspondientemente. 

 

Ilustración 3.9. Susceptibilidad a Deslizamientos 

Por otro lado, para caídas los valores máximos de los factores han sido: 

- Pendiente: 5 

- Cobertura vegetal: 5 

- Litología: 3 

La respectiva multiplicación que corresponde a susceptibilidad de caídas presentó como 

valores mínimos y máximos de 0 y 75 correspondientemente. 
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Ilustración 3.10. Susceptibilidad a Caídas 

 

3.6 Factor de disparo por precipitaciones (Tp) 

Dentro de la metodología escogida, se considera a la intensidad de precipitaciones como 

factor de disparo. El Instituto Nacional de Hidrología y Meteorología (INHAMI), a partir 

de la aplicación de la metodología de Mora–Vahrson (1993) y con base a los registros de 

estaciones meteorológicas determinó que a nivel nacional existe una precipitación 

máxima en 24 horas de 245mm para un periodo de retorno de 100 años, a partir de este 

valor se presentó el cuadro para calificar el factor detonante para precipitaciones  

Tabla 3.5. Categorización del factor disparo por precipitaciones 

Precipitación 
máximas 24 horas, 

Tr 100 a (mm) 
Calificativo Ponderación 

< 100 Muy bajo 1 

100 - 150 Bajo 2 

150 - 200 Mediano 3 

200 - 250 Alto 4 

> 250 Muy alto 5 

Fuente: IEE, 2015 
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3.6.1 Mapa de Precipitaciones 

 

De acuerdo a la metodología se requiere el mapa de precipitaciones de los valores 

máximos anules para una duración de 24 horas.  

Por lo cual se consideraron los registros de precipitación de las estaciones 

meteorológicas del INAMHI (Instituto Nacional de Meteorología en Hidrología), del 

periodo 1981 – 2010 y se delimitaron los datos dentro de la Subcuenca del Río 

Guayllabamba, considerando que existen ciertas limitaciones en lo que refiere a 

existencia y disponibilidad de información meteorológica en el área del estudio, con 

estos datos se creó una tabla en Excel, la misma que se importó en ArcMap. 

Para el análisis de los 64 datos de precipitación se utilizó el software estadístico 

Statghaphics Centurion. 

Tabla 3.6. Estaciones meteorológicas 

No. 
Estación 

Código Estación 
Este 
(m) 

Norte 
(m) 

Altura 
(m) 

VALOR_MAX 
(mm) 

1 M002 LA_TOLA 793124 9974615 2479 79,20 

2 M003 IZOBAMBA 772119 9959514 3052 84,50 

6 M009 LA_VICTORIA_INERHI 798621 9994129 2240 56,20 

7 M022 TABACUNDO_H.MOJANDA 807571 10005688 2940 206,70 

8 M023 OLMEDO-PICHINCHA 825692 10015691 3120 131,90 

9 M024 QUITO_INAMHI-INNAQUITO 779647 9980274 2789 71,60 

10 M046 PACHIJAL_MASHPI 730325 10017851 560 143,00 

11 M054 QUITO-OBSERVATORIO 777903 9976198 2820 45,70 

12 M055 QUITO_AEROPUERTO-DAC 779273 9984243 2811 76,20 

13 M111 MALCHINGUI_INAMHI 796186 10006558 2840 61,70 

14 M112 CONOCOTO 781176 9967384 2520 92,60 

15 M113 UYUMBICHO 775507 9956852 2700 124,00 

16 M114 TUMBACO 788222 9976295 2350 73,60 

17 M115 SAN_ANTONIO_DE_PICHINCHA 785464 9999105 2430 47,80 

18 M117 MACHACHI 770803 9943779 2910 42,90 

19 M118 INIAP-SUPLEMENTARIA_PORCINOS 777651 9959418 2650 74,00 

20 M120 COTOPAXI-MINITRAK 769381 9931195 3590 49,80 

21 M121 EL_REFUGIO-COTOPAXI 785328 9927386 4570 61,30 

22 M210 VINDOBONA 788069 9999016 2060 65,30 
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23 M211 LA_VINNA_DE_CHESPI 775294 10015404 1500 70,80 

24 M213 LA_PERLA 757706 10021595 1260 83,50 

25 M214 PERUCHO_INECEL 786881 10012134 1830 53,60 

26 M216 SAN_MIGUEL_DE_LOS_BANCOS 734510 10003031 1140 177,00 

27 M318 APUELA-INTAG 776750 10039267 1583 108,50 

1 M325 GARCIA_MORENO 764105 10025979 1474 110,30 

28 M326 SELVA_ALEGRE-IMBABURA 769716 10027254 1594 83,30 

29 M327 CHONTAL_BAJO(GUAYLL.DJ_ALAMBI) 750516 10026244 700 126,60 

30 M335 LA_CHORRERA 775086 9977140 3165 140,00 

31 M336 PACTO 748516 10015865 1160 185,80 

32 M337 SAN_JOSE_DE_MINAS 788317 10019498 2440 76,20 

33 M338 PERUCHO_INAMHI 787035 10012634 1820 47,10 

34 M339 NANEGALITO 757781 10007068 1610 129,60 

35 M341 GUAYLLABAMBA 795832 9993791 2150 100,30 

36 M342 COTOCOLLAO 778807 9987139 2870 54,40 

37 M343 EL_QUINCHE-PICHINCHA 801004 9986991 2605 57,50 

38 M344 CANGAHUA 815332 9993576 3140 60,40 

39 M345 CALDERON 786815 9989089 2690 61,60 

40 M346 YARUQUI_INAMHI 798801 9982303 2600 73,30 

41 M347 PUEMBO 794333 9980821 2460 65,10 

42 M349 HDA.PINANTURA(LA_COCHA) 794093 9952556 3250 49,20 

2 M352 SANGOLQUI 785151 9962637 2480 72,40 

43 M353 RUMIPAMBA-PICHINCHA 787320 9952232 2940 107,10 

44 M356 CANAL_4_TV. 776130 9981424 3500 64,60 

45 M357 CANAL_10_TV. 775467 9981398 3780 72,60 

46 M358 CALACALI_INAMHI 776854 9999880 2810 76,90 

47 M359 CAYAMBE 818117 10005609 2840 100,10 

48 M361 NONO 769748 9992833 2710 119,40 

49 M364 LORETO_PEDREGAL 783301 9941818 3465 137,00 

50 M524 CHONTAL_ALTO 753517 10030223 1340 109,80 

51 M532 RIO_PITA-HDA.PEDREGAL 787430 9943255 3600 31,00 

52 M566 ASCAZUBI_INAMHI 801828 9991375 2580 42,00 

53 M572 CUMBAYA 786767 9978766 2370 60,90 

54 M574 HDA.JERUSALEN 794144 9999312 2300 26,50 

55 M577 CAJAS_PEDREGAL 792553 9929524 3830 51,50 

56 M587 NANEGAL 759187 10016453 1180 116,90 

57 M605 COCHASQUI-HDA._INAMHI 799023 10005825 2960 44,40 

58 M606 QUITO-U.CENTRAL 777645 9977792 2870 74,50 

59 M607 MANDURIACO_CHICO 743811 10031401 1000 145,30 
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60 M612 GUAYCUYACU 742601 10018000 1720 144,00 

3 M621 CUELLAJE 775484 10044191 1890 72,70 

61 M622 RIO_PITA_AJ_SALTO 785131 9945120 3360 61,20 

62 M721 MESA_MIRAVALLE(DEL_CHONTAL) 751794 10024579 960 116,00 

63 M730 LLULLUCHIS 762633 9931890 3410 46,00 

64 M913 HDA.MI_CIELO(PV18) 777192 9981653 3173 131,10 

Fuente: INAMHI 

 

Se realizaron diferentes pruebas de normalidad: Chi-Cuadrado y Shapiro-Wilk, indicando 

un valor-P menor a 0,05 por lo que se puede rechazar la idea de que los valores máximos 

de precipitaciones provienen de una distribución normal con 95% de confianza. 

Tabla 3.7. Pruebas de normalidad - Precipitación máxima en 24 horas 

 

 

Se puede observar en la ilustración 3.11., que el histograma se acumula en la zona 

izquierda de la curva, observándose que no sigue una distribución normal, ratificando 

las anteriores pruebas de normalidad realizadas. 

 

Ilustración 3.11. Histograma - Precipitación máxima en 24 horas 
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Ilustración 3.12. Flujograma que indica el mecanismo para elegir el método de interpolación 

Fuente: Adaptado de Dalence, S. (2012) 

 

De acuerdo al flujograma de la ilustración 3.12., que indica el mecanismo para elegir el 

método de interpolación, se decidió utilizar el método IDW (Ponderación de distancia 

inversa), dando como resultado: 
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Ilustración 3.13. Interpolación de Precipitaciones 

 

Los valores mínimos y máximos de precipitación máxima en 24 horas, son 26,5mm y 

206,7mm correspondientemente, los cuales después de ser interpolados se ponderan 

de acuerdo a la metodología. Cabe indicar que las ponderaciones serán las mismas para 

el análisis de deslizamientos y caídas. 
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Ilustración 3.14. Interpolación de Precipitaciones Reclasificado 

Una vez ponderado, se recortará el área de interés. Donde las precitaciones se 

encuentran en la categoría 1 de la metodología, ya q ha presentado valores <100mm. 

 

Ilustración 3.15. Precipitaciones Reclasificado de Pomasqui 

<100mm 
100 – 150mm 
150 – 200mm 
200 – 250mm 
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3.7 Factor de disparo por sismos (Ts) 

Los movimientos en masa producidos por actividad sísmica se dan por su intensidad. 

Para la categorización de este factor de disparo se basó en el cuadro comparativo entre 

la intensidad y la magnitud de los sismos de Mora-Vahrson (1993). 

Considerando los efectos que tiene la magnitud de los sismos en la superficie se deberá 

seguir la siguiente ponderación para el factor de disparo por sismos. 

Tabla 3.8. Categorización del factor disparo por sismicidad 

Rangos 
Magnitud 

Richter 
Calificativo Ponderación 

< 3,5 Nulo 0 

3,5 - 4,4 Muy bajo 1 

4,5 - 5,9 Bajo 2 

6,0 - 6,9 Mediano 3 

7,0 - 7,9 Alto 4 

> 8,0 Muy alto 5 

Fuente: IEE, 2015 

 

3.7.1 Mapa de Sismos 

 

A partir de los registros de sismos proporcionados por el Instituto Geofísico – EPN en su 

página web oficial, se recopilaron datos durante el periodo 1901 – 2015. Se realizó la 

misma delimitación de los datos dentro de la Subcuenca del Río Guayllabamba, y se 

obtuvieron 93 registros dentro del área de estudio. Se trataron los datos de la misma 

manera que para precipitaciones. 

Se realizaron las pruebas de normalidad: Chi-Cuadrado y Shapiro-Wilk, debido a que el 

valor-P más pequeño de las pruebas realizadas es menor a 0,05, se puede rechazar la 

idea de que Magnitud proviene de una distribución normal con 95% de confianza. 

. 
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Tabla 3.9. Pruebas de normalidad - Sismos 

 

 

Se puede observar en la ilustración 3.16., que el histograma se acumula en la zona 

izquierda de la curva, observándose que no sigue una distribución normal, ratificando 

las anteriores pruebas de normalidad realizadas. 

 

Ilustración 3.16. Histograma – Sismos 

 

Con lo cual se concluye que los datos de Magnitud de los sismos no siguen una 

distribución normal si no una distribución asimétrica positiva.  

De acuerdo al flujograma de la ilustración 3.12., que indica el mecanismo para elegir el 

método de interpolación, se decidió utilizar el método IDW (Ponderación de distancia 

inversa), dando como resultado: 
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Ilustración 3.17. Interpolación de Sismos 

Los valores mínimos y máximos de la magnitud de los sismos en la escala de Richter, son 

3,5 y 5,6 correspondientemente, los cuales después de ser interpolados se ponderan de 

acuerdo a la metodología. Para el análisis de deslizamientos y caídas las ponderaciones 

del factor sismos serán las mismas. 
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Ilustración 3.18. Interpolación de Sismos Reclasificado 

Una vez ponderado, se recortará el área de interés. Donde los valores de la magnitud de 

sismos, se encuentran en las categorías 1 y 2 de acuerdo a la metodología, ya q ha 

presentado valores entre 3,5 – 5,9. 

 

Ilustración 3.19. Sismos Reclasificado de Pomasqui 

3,5 – 4,4 
4,5 – 5,9 
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3.8 Determinación del Grado de amenaza (H) 

El cálculo de la amenaza para la ocurrencia de fenómenos de remoción en masa, tanto 

para deslizamientos como caídas, se lo realiza mediante la fórmula: 

𝐻 = (𝑆𝑚 × 𝑆𝑐 × 𝑆𝑙) × (𝑇𝑠 + 𝑇𝑝) 

 

Cabe mencionar que el resultado de este producto, no está establecido en una escala 

única de valores del indicador, pues éstos deben ajustarse a las condiciones de cada área 

estudiada. No obstante, se sugiere dividir el rango de valores obtenidos, para cada área 

de estudio en cinco clases de amenaza y asignar los calificativos que se presentan en la 

siguiente tabla. El calificativo de amenaza es una representación cualitativa de los 

diferentes niveles de amenaza y no una amenaza propiamente dicha. 

Tabla 3.10. Clasificación de Amenaza 

Clase 
Calificativo de 

Amenaza 
Características 

I Muy baja 

Sectores estables, no se requieren medidas correctivas. 
Se debe considerar la influencia de los sectores aledaños con 
susceptibilidad de moderada a muy alta. 
Sectores aptos para usos urbanos de alta densidad y ubicación de 
edificios indispensables como hospitales, centros educativos, estaciones 
de policía, bomberos, etc 

II Baja 

Sectores estables que requieren medidas correctivas menores, 
solamente en caso de obras de infraestructura de gran envergadura. 
Se debe considerar la influencia de los sectores aledaños con 
susceptibilidad de moderada a muy alta. 
Sectores aptos para usos urbanos de alta densidad y ubicación de 
edificios indispensables como hospitales, centros educativos, estaciones 
de policía, bomberos, etc. 
Los sectores con rellenos mal compactados son de especial cuidado. 

III Moderada 

No se recomienda la construcción de infraestructura si no se realizan 
estudios geotécnicos y se mejora la condición del sitio. 
Las mejoras pueden incluir: movimientos de tierra, estructuras de 
retención, manejo de aguas superficiales y subterráneas, reforestación, 
entre otros. 
Los sectores con rellenos mal compactados son de especial cuidado. 
Recomendable para usos agropecuario. 

IV Alta 

No se recomienda la construcción de infraestructura, para su utilización 
se deben realizar estudios de estabilidad a detalle y la implementación 
de medidas correctivas que aseguren la estabilidad del sector, en caso 
contrario, deben mantenerse como áreas de protección. 
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V Muy alta 
No se recomienda la construcción de infraestructura 
Se recomienda como áreas de protección.  

Fuente: Mora, R. et al., 1993 

 

Por lo cual, se decidió clasificar los resultados según el método Rupturas Naturales 

(Jenks), donde las clases se caracterizan porque agrupan mejor los valores similares y 

maximizan las diferencias entre clases. Es decir, las entidades se dividen en clases cuyos 

límites quedan establecidos donde hay diferencias considerables entre los valores de los 

datos. 

3.8.1 Grado de Amenaza de Deslizamientos 

 

En un principio se obtuvo como resultados valores entre 0 y 300, que representan la 

amenaza de deslizamientos. 

 

 

Ilustración 3.20. Amenaza de Deslizamientos 
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Para reclasificarlo según el método Rupturas Naturales (Jenks), se usó la herramienta 

RECLASSIFY 

Esta herramienta se encuentra en ArcToolBox > Spatial Analyst Tools > Reclass > 

Reclassify 

En las propiedades de reclasificación se seleccionó como método de clasificación: 

Natural Breaks (Jenks) y número de clases: 5, como se muestra en la siguiente 

ilustración. 

 

Ilustración 3.21. Parámetros reclasificación de amenaza de Deslizamientos 

Lo cual indica que a los valores entre: 

- 0 – 12   categoría 1  amenaza muy baja 

- 12 – 45   categoría 2  amenaza baja 

- 45 – 81     categoría 3  amenaza moderada 

- 81 – 144  categoría 4  amenaza alta 

- 144 – 300  categoría 5  amenaza muy alta 
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Ilustración 3.22. Amenaza de Deslizamientos Reclasificado 

3.8.2 Grado de Amenaza de Caídas 

Para la amenaza de caídas se obtuvo como resultados valores entre 0 y 225. 

 

Ilustración 3.23. Amenaza de Caídas 



 

 MASTER EN INGENIERÍA GEOMÁTICA Y GEOINFORMACIÓN 

 SUSCEPTIBILIDAD A DESLIZAMIENTOS DE TIERRA EN LA PARROQUIA POMASQUI - ECUADOR 

 

53 
 

Para reclasificarlo según el método Rupturas Naturales (Jenks), se usó la herramienta 

RECLASSIFY 

Esta herramienta se encuentra en ArcToolBox > Spatial Analyst Tools > Reclass > 

Reclassify. En las propiedades de reclasificación se seleccionó como método de 

clasificación: Natural Breaks (Jenks) y número de clases: 5, como se muestra en la 

siguiente ilustración. 

 

Ilustración 3.24. Parámetros reclasificación de amenaza de Caídas 

Lo cual indica que a los valores entre: 

- 0 – 8   categoría 1  amenaza muy baja 

- 8 – 32   categoría 2  amenaza baja 

- 32 – 54     categoría 3  amenaza moderada 

- 54 – 100  categoría 4  amenaza alta 

- 100 – 225  categoría 5  amenaza muy alta 
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Ilustración 3.25. Amenaza de Caídas Reclasificado 
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Factores 

Condicionantes 

Factores 

Disparadores 

Mapa de Amenaza de 

Deslizamientos 

Amenaza de Deslizamientos 

 

 

 

 

 

 

 

Pendientes (Sm) 

Litología (Sl) 

Cobertura Vegetal (Sc) 

Precipitaciones (Tp) 

Sismos (Ts) 

× = 

Ilustración 3.26. Resumen de los factores condicionantes (pendientes, 
litología, cobertura vegetal) y de disparo (precipitaciones, sismos) 

(derecha) Mapa de amenaza de deslizamientos: H=(SmxScxS)l x (Ts+Tp) 
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Factores 

Condicionantes 
Factores 

Disparadores 

Mapa de Amenaza de 

Caídas 

Amenaza de Caídas 

 

 

 

 

 

 

 

Pendientes (Sm) 

Litología (Sl) 

Cobertura Vegetal (Sc) 

Precipitaciones (Tp) 

Sismos (Ts) 

× = 

Ilustración 3.27.Resumen de los factores condicionantes (pendientes, 
litología, cobertura vegetal) y de disparo (precipitaciones, sismos) 

(derecha) Mapa de amenaza de caídas: H=(SmxScxS)l x (Ts+Tp) 
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CAPITULO IV 

4. RESULTADOS 

4.1 Determinación del Grado de Amenaza (H) 

4.1.1 Grado de Amenaza de Deslizamientos 

 

El modelo obtenido de amenaza de deslizamientos de la parroquia Pomasqui se ha 

categorizado en 5 clases: 

Amenaza de Deslizamientos – Muy Baja 

 

En esta zona se encuentra la población Pomasqui que cuenta con alrededor de 30 000 

habitantes y es una zona en constante crecimiento urbanístico debido a la cercanía al 

centro de Quito. 

 

Ilustración 4.1. Amenaza de deslizamientos – Muy Baja 
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Las zonas con amenaza muy baja tiene un área de aproximadamente 7 569 599,35m² 

(7,56k m²) siendo el 32,10% de la totalidad de la superficie de la parroquia, tiene 

pendientes, planas, suaves y muy suaves con valores desde los 0 – 12%, principalmente 

se ubica sobre depósitos aluviales con una litología de gravas, arenas en matriz areno-

arcilloso y depósitos coluviales con su litología de arenas de grano medio a grueso, 

gravas y cantos subangulares a angulares, en cuanto a su cobertura vegetal presenta en 

su mayoría zonas urbanas y en proceso de urbanización y en menor parte pastos 

cultivados. 

 

Ilustración 4.2. Amenaza de deslizamientos – Muy Baja 
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Amenaza de Deslizamientos – Baja  

 

El grado de amenaza bajo tiene una extensión de aproximadamente 3 019 656,83m² 

(3km²) correspondiente al 12,80% del total de la superficie de la parroquia. 

Relacionados principalmente a relieves volcánicos montañosos hasta relieves volcánicos 

bajos, superficies volcánicas onduladas. Sus pendientes están dentro del rango medio y 

medio fuertes con valores entre 12 – 40%, sobre la formación Cangahua. Con respecto 

a su cobertura vegetal presenta: pasto cultivado, maíz, vegetación arbustiva, plantación 

forestal. 

 

Ilustración 4.3. Amenaza de deslizamientos – Baja 
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Amenaza de Deslizamientos – Media  

 

El grado de amenaza medio ocupa un área de 9 645 482,35m² (9,64 km²), que 

corresponde al 40,90% de la totalidad de la extensión de Pomasqui, está sobre geología 

de formación Cangahua y su litología son depósitos de toba volcánica y ceniza, en la base 

se encuentran piroclastos, pómez y lapilli. Presenta diferentes tipos de cobertura 

vegetal desde: matorral seco muy alterado (3), matorral seco medianamente alterado, 

vegetación herbácea seca muy alterada, vegetación herbácea seca poco alterada. 

 

Ilustración 4.4. Amenaza de deslizamientos – Media 
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Amenaza de Deslizamientos – Alta  

 

Tiene una extensión de 2951 637,96m² (2,95km²) correspondientes al 12,50% del total 

de la extensión de la parroquia Pomasqui, está ubicado principalmente en los flancos 

del volcán y barrancos por donde atraviesan los drenajes. Tiene pendientes fuertes y 

muy fuertes con valores entre 40 – 150 %. Está sobre la formación Cangahua donde su 

litología son depósitos de toba volcánica y ceniza, en la base se encuentran piroclastos, 

pómez y lapilli. La cobertura vegetal corresponde a vegetación herbácea seca poco 

alterada, matorral seco medianamente alterado e incluso áreas en proceso de erosión 

 

Ilustración 4.5. Amenaza de deslizamientos – Alta 
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Amenaza de Deslizamientos – Muy Alta 

 

Dentro de la categoría de amenaza de deslizamientos muy alta, tiene un área de 403 

728,09 m², que corresponde al 1,7% del total de la superficie de la parroquia. Presenta 

pendientes muy fuertes con valores que oscilan entre los 70 – 200%. En la zona norte en 

el cauce del Río Monjas presenta una geología de depósitos aluviales (4), y una litología 

de gravas, arenas en matriz areno-arcilloso. No cuenta con cobertura vegetal, se debe 

indicar que a sus alrededores tiene infraestructuras antrópicas (4). Por lo cual todos 

estos factores suman a que exista una amenaza muy ata. 

En la zona noreste que corresponde a los barrancos que presentan pendientes fuertes y 

muy fuertes q=con valores que oscilan entre los 70 – 200%, tiene una geología que 

corresponde a depósitos coluviales con una litología de arenas de grano medio a grueso, 

gravas y cantos subangulares a angulares, con respecto a la cobertura vegetal cabe 

recalcar que no la tiene ya que es una zona erosionada (5) muy amplia. 

 

Ilustración 4.6. Amenaza de deslizamientos – Muy Alta 
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4.1.2 Grado de Amenaza de Caídas 

 

El modelo obtenido de amenaza de caídas de la parroquia Pomasqui se ha categorizado 

en 5 clases: 

 

Amenaza de Caídas – Muy Baja 

 

El grado de amenaza muy bajo corresponde a las zonas más planas de la parroquia, con 

una extensión de 13164881,09m² (13,16 km²) equivalente al 55,82% de la totalidad de 

la extensión de la parroquia Pomasqui. Presenta pendientes muy suaves y suaves con 

valores de 0 – 12%. Está ubicado sobre depósitos aluviales (1) y presenta diferente 

cobertura vegetal como: pasto cultivado (3), misceláneo de hortalizas (4), eucalipto (1), 

pero en su mayoría son zonas urbanas (4) ya que en esta zona se asienta la población de 

Pomasqui. 

 

Ilustración 4.7. Amenaza de caídas – Muy Baja 
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Cabe indicar que en esta zona se encuentra la población Pomasqui que cuenta con 

alrededor de 30 000 habitantes y es una zona en constante crecimiento urbanístico 

debido a la cercanía al centro de Quito 

 

Ilustración 4.8. Amenaza de caídas – Muy Baja 
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Amenaza de Caídas – Baja 

 

El grado de amenaza bajo ocupa una superficie de 6 460 451,46m² (6,46 km²) 

correspondiente al 27,39% de la totalidad de la superficie de la parroquia. Sus 

pendientes son fuertes con valores entre 40 y 70%, sobre una geología de la formación 

Cangahua y una litología de depósitos de toba volcánica y ceniza, en la base se 

encuentran piroclastos, pómez y lapilli. Corresponde a los flancos del Volcán Casitagua 

con pendientes no tan pronunciadas  

En las terrazas próximas al Río Monjas se presentan pendientes con valores de 40 – 100% 

y una geología de Depósitos aluviales, con una litología de Gravas, arenas en matriz 

areno-arcilloso. 

Presenta una cobertura vegetal de matorral seco muy alterado (3), matorral seco 

medianamente alterado (3), vegetación herbácea seca muy alterada (4), áreas 

erosionada (5). 

 

Ilustración 4.9. Amenaza de caídas - Baja 
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Amenaza de Caídas – Media 

 

El grado de amenaza medio o moderado tiene un área de 3 479 920,97m² (3,47km²) que 

corresponde al 14,75% de la totalidad de la superficie, se ubica principalmente en zonas 

de los flancos del volcán con pendientes con valores que oscilan entre los 40 -100%, su 

geología es principalmente la Formación Cangahua con su litología de depósitos de toba 

volcánica y ceniza, en la base se encuentran piroclastos, pómez y lapilli. Presenta 

diferentes tipos de cobertura vegetal como: vegetación herbácea seca poco alterada, 

vegetación herbácea seca muy alterada, áreas en proceso de erosión, vegetación 

herbácea seca muy alterada, matorral seco muy alterado, matorral seco medianamente 

alterado. 

 

Ilustración 4.10. Amenaza de caídas – Media 
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Amenaza de Caídas – Alta 

 

El grado de amenaza alto ocupa aproximadamente 448 044,26m² correspondiente al 

1,9% de la totalidad de la superficie de la parroquia, principalmente asociado a zonas de 

los flancos del volcán y barrancos (quebradas) por donde atraviesa la red hidrográfica. 

Con pendientes muy fuertes que oscilan entre 40 – 100%, una geología de depósitos 

coluviales con su litología de arenas de grano medio a grueso, gravas y cantos 

subangulares a angulares como indica el mapa geológico. Presenta áreas en proceso de 

erosión (5), vegetación herbácea seca muy alterada (4). 

Cabe indicar que además las zonas ubicadas al lado noreste están próximas a uno y dos 

kilómetros de 2 sismos de 5,3 y 5,1 de magnitud en la escala de Richter producidos en 

los años 1990 y 2014 respectivamente. Por lo cual se entendería este tipo de amenaza. 

 

Ilustración 4.11. Amenaza de caídas - Alta 
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Amenaza de Caídas – Muy Alta 

 

El grado de amenaza muy alto corresponde a aproximadamente 39 899,57m² siendo el 

0,17% de la totalidad de la superficie, está ubicado en el noreste de Pomasqui. 

Presentando pendientes muy fuertes con valores que oscilan entre 70 – 200%, su 

geología corresponde a la formación Cangahua y su litología son depósitos de toba 

volcánica y ceniza, en la base se encuentran piroclastos, pómez y lapilli. En cuanto a 

cobertura vegetal se encuentra sobre áreas erosionadas y vegetación herbácea seca 

poco alterada.  

Cabe indicar que además estas zonas se encuentran aproximadamente a uno y dos 

kilómetros de cercanía de 2 sismos de 5,3 y 5,1 de magnitud en la escala de Richter 

producidos en los años 1990 y 2014 respectivamente. 

Todos estos factores suman para presentar en el modelo una amenaza de caídas muy 

alto, dentro de la categoría 5.  

 

Ilustración 4.12. Amenaza de caídas – Muy Alta 
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CAPITULO V 

5. CONCLUSIONES 

 

A pesar que se obtuvo un modelo bastante coherente con la realidad según los 

resultados alcanzados con los índices calculados e incluso al compararlos con otros 

documentos bibliográficos correspondientes a la zona de estudio, cabe mencionar que 

la metodología empleada posee ciertas limitantes que pueden modificar los resultados 

parciales y/o finales. Básicamente, dependen o se ven afectados por la falta de 

información secundaria disponible, por ejemplo: fue necesario fotointerpretar y 

digitalizar la geomorfología de la zona estudiada, así como también requiere poseer un 

mapa de cobertura vegetal actualizado y a una escala adecuada ya que en la actualidad 

existen problemas en cuanto a pérdidas de cobertura vegetal por incendios o por 

actividades antrópicas en especial crecimiento urbanístico, mismas que cambian su 

cobertura vegetal. Por cuanto es imperativo mantener actualizada dicha cartografía 

para poder generar modelos más precisos. 

Cabe recalcar que esta metodología posee como limitaciones la información secundaria 

ocupada, como se lo menciono anteriormente, el objetivo principal del presente estudio 

es identificar zonas susceptibles de deslizamientos de tierra en la parroquia Pomasqui, 

por medio de esta metodología es factible realizarlas, pero si se desea estudios 

detallados de las zonas encontradas con un grado de amenaza alto y muy alto, es 
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necesario realizar estudios geotécnicos del lugar de interés para realizar o tomar 

medidas de prevención y mitigación dependiendo del caso. 

Se encontraron cinco grados de amenaza de caídas de tierra en la parroquia Pomasqui, 

de los cuales el grado de amenaza de caídas alto y muy alto no llegan a sumar un 2,04%. 

Por otro lado, de las cinco categorías de amenaza para deslizamientos la sumatoria de 

amenaza alta y muy alta es 14,2%.   

Se encontraron tres denominaciones geológicas en la zona de estudio, la Formación 

Cangahua que forma a los flancos del volcán, depósitos coluviales representados por los 

pedimentos al pie de los flancos del volcán y los depósitos aluviales formando a las 

distintas terrazas aluviales. De todos ellos las que poseen mayor incidencia o se ven 

relacionadas con un grado de amenaza muy alto y alto de deslizamientos y caídas de 

tierra, es a la Formación Cangahua y a los depósitos coluviales, lo cual es coherente por 

su composición.  

La ponderación regional para toda el área de estudio para los factores detonantes fue 

de valor tres – ponderando uno para el factor de precipitaciones y dos para el factor 

sismos-, además las fuertes pendientes de los flancos del volcán como de su caldera 

fueron las determinantes en cuanto al grado de amenaza obtenido. 

La población de Pomasqui se encuentra situada en su mayor parte en el grado de 

amenaza a deslizamientos y caídas muy bajo, pero también se identifican a los 

alrededores del poblado Pomasqui, procesos de urbanización desarrollándose en un 

grado de amenaza medio, el cual corresponde morfológicamente a uno de los flancos 

del volcán Casitagua, pero con menor pendiente. 

A pesar que el grado de amenaza medio de caídas ocupa un 14,75% y el grado de 

amenaza medio de deslizamientos un 40,90%, de la superficie de la totalidad de la 

parroquia, es en donde se están llevando a cabo procesos de urbanización al igual que 

es por donde cruza la única vía de acceso principal para la parroquia, por lo tanto, es 

importante realizar estudios de mayor detalle (geotécnicos) en donde se puedan 
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identificar zonas en las que sea necesario la construcción de obras de mitigación o 

prevención de este tipo de eventos. 
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